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Manage content and app windows 

As the name of the Windows 10 operating system indicates, most of the information you 

view on your computer is displayed in windows—rectangular content frames. Windows 

have common features. Depending on which system or app generates the window, 

its controls might look slightly different, but in general, a window has a title bar at the top 

that has a title in the middle and window-management buttons on the right side.  

Note: When an app or system element is active, its window has a corresponding taskbar 

button. 

The three buttons on the right end of the title bar are: 

 Minimize: Minimizing a window doesn’t close the file or app in the window, but 

closes the window on the screen. You can reopen the window by selecting the 

corresponding taskbar button. 

 Maximize/Restore: When a window fills only part of the screen, maximizing it 

increases it to full-screen size. When a window is maximized, restoring it returns it to 

its previous part-screen size. 

 Close: Closing a window also closes the file or app that the window contains. 

 

 

 

 

 

 

 

 

 

Maximize 

Close 

Minimize Restore 
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To resize a window 

 To manually change only the window height, point to the top or bottom of 

the window frame, and when the pointer changes to a double-headed arrow, drag the 

arrow up or down. 

 To manually change only the window width, point to the left or right side of 

the window frame, and when the pointer changes to a double-headed arrow, drag the 

arrow left or right. 

 To manually change the window size in any direction, point to a corner of 

the window frame, and when the pointer changes to a diagonal arrow, drag the 

arrow in any direction. 

 

To maximize the height of a window without changing the width 

 Point to the top or bottom of the window frame, and when the pointer changes 

to a double-headed arrow, double-click. 

 

To maximize a window 

 Double-click the window title bar. 

 At the right end of the title bar, select the Maximize button. 

 Drag the window by its title bar to the top of the screen, and then release it. 

 Press Win+Up Arrow to maximize a non-snapped window. 

 

To restore a maximized window 

 Double-click the window title bar. 

 At the right end of the title bar, select the Restore button. 

 Drag the window by its title bar away from the top of the screen, and then release 

it. 

 Press Win+Down Arrow to restore a non-snapped window. 
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To minimize the active window 

 At the right end of the title bar, select the Minimize button. 

 Press Win+Down Arrow to minimize a non-maximized window. 
 

To minimize all windows 

 Press Win+M. 

 

To restore minimized windows 

 Press Win+Shift+M. 
 

To close a window 

 At the right end of the title bar, select the Close button. 

 

Move and arrange windows 

Most people have at least a few windows open at the same time. You can move and 

arrange windows by dragging them around the screen. 

To drag a window 

 Press and hold the window title bar by using the primary mouse button, your 

finger. 

 Move the pointing device until the window is where you want it. 

To move a window 

 Drag the window by its title bar to the new position. 

 Press Win+Left Arrow or Win+Right Arrow to cycle the active window 

through the left, right, and center of each screen. 
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Switching between windows 

 If you have more than one window open at the same time, you can quickly switch 

between them by clicking the icon for that window on the taskbar. 

 

Working with the File Explore 

File Explorer is a tool used to perform the file management tasks which can display the 

contents of your computers such as all the drives, folders, and files that are stored on your 

computer. 

To open File Explorer, click on the File Explorer icon located in the taskbar. 

 

 

 

Alternatively, you can open File Explorer by clicking on the Start button and then clicking 

on File Explorer. 
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File Explorer Parts Description 

 

 

 

 

 

 

 

 

 

 

 

1. Navigation Pane 

From the Navigation pane, you can view your computer’s file and folder structure and 

access files and folders. 

In the Navigation pane is the Quick access area; from the Quick access area, you 

can quickly and easily navigate to folders you use regularly. To add (pin) a folder to the 

Quick access area, right-click on the folder name and then select Pin to Quick 

access from the drop-down menu. 

 

2. Forward and Back buttons: Enables you to go to folders you’ve already 

opened. If you go to a different folder, you can choose the Back button to return to 

the last folder you accessed. 

 

3. Ribbon: Enables you to perform layout (file), formatting (home), and 

sharing (share) tasks, as well as how File Explorer displays your files and folders. 
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Tasks available to you might differ depending on what folder you select (e.g., Documents 

vs Pictures). 

To display the Ribbon, click on one of the menu items at the top of File Explorer, or 

click on the Expand the Ribbon button (down-pointing arrow) located at the top 

right-hand side of File Explorer. 

 

 

 

 

 

 

 

 

4. Address Bar: Enables you to go to a different folder in the same Explorer window.  

 

5. Column headings: Titles of each of the columns displayed in the file and folder 

list. You can choose which columns you want to display by adding a column heading or 

removing a column heading, as well as changing the order in which those columns are 

displayed. Click on a column heading to sort your files and folders by that column (e.g., 

date modified). 

 

6. Search Box: Allows you to search for subfolders, documents, images, programs, 

Web pages, and bookmarks in the current folder. 

 

7. File and Folder Listing: Shows you the files and folders in the current folder 

(the folder you selected in the Navigation pane). 

 

8. Preview/Details pane: Enables you to quickly preview an item, such as a photo, 

without having to open that item. To open the Preview pane (it isn’t open by default), 

click on the View menu at the top of File Explorer, then click on the Preview pane 

button located at the left-hand side of the Ribbon in the Navigation pane area. 

 

9. Status Bar: Displays information about a selected folder and its contents, such as the 

total number of items in the folder, the number of items selected and total file size. 
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Contains buttons that enable you to quickly switch between thumbnail and detail views 

for the items displayed in the current folder. 

 

With Windows 10, if a folder contains subfolders, that folder name will instead have a 

small right pointing triangle next to it. 

 

No triangle next to a folder name means the folder has no subfolders. 

 

Right-pointing triangle next to a folder name means that the folder has 

subfolders. 

Down-pointing triangle next to a folder name means that subfolders are 

currently displayed for that folder. 

 
 

To view a folder’s subfolders, click on the right-pointing triangle next to the folder and the 

subfolders will be displayed, as shown below.  

 

 

 

 

 

 

 

 

 

Home Tap 

Gives you access to the most often used file management commands. The Clipboard 

group includes all the standard commands (Copy, Paste, Cut), along with the handy 

Copy Path command. Just select a folder or file, click the Copy Path command, 

and the current path is copied to the clipboard. 
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In the Organize group, you’ll find that the Move To and Copy To commands are 

readily accessible. The Delete and Rename commands also live in this group. 
 

 Move To 

Select a folder or file, click the Move To command, and select the new 

location from the drop down menu that the selected folder or file to move to. 
 

 Copy To 

Select a folder or file, click the Copy To command, and select the new 

location from the drop down menu that the selected folder or file to Copy to. 
 

The New group lets you create new folders and files of various types. 

 Within File Explorer, select the New folder button. You can also right-click where 

you want the folder to appear, then select New > Folder. Type the desired name for 

the folder and press Enter. 
 

The Select group offers a set of commands for selecting groups of files and folders. 
 

 

View Tap 
 

On the View tab you’ll find a host of commands for configuring the way File 

Explorer displays files.  
 

In the Panes group, you can configure the Navigation pane and enable or disable the 

Preview pane or the Details pane.  
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The Layout group sports a live preview gallery for choosing your icon display. Just 

hover over an option in the gallery, and the file display changes accordingly. 
 

Tiles: Shows icons of each item. Files also show file type and file size. 
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Details: Lists and shows information about your files and folders. In this view, folders 

show date last modified; files also show file type, file size, and date created. 

 

 

 

 

 

 

 

 

 
 

List: Shows you the file or folder name and its associated icon. 

 

Small, Medium and Large Icons: show the icons in a small, medium or a larger view 

of file and folder icons. The name of the file or folder is displayed. Windows displays a 

thumbnail of images. 

 

 

The Current View group exposes several great commands. The Group By and Sort 

By commands give you neat ways to narrow and organize the display of your files so 

they’re readily available. 
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Explore Windows settings 

At some point, you may want to adjust your computer's settings. For example, you 

might want to change your desktop background or modify your Internet settings. In 

versions of Windows prior to Windows 10, the various settings that controlled the 

behavior of the computer were available from Control Panel. Control Panel still exists 

in Windows 10, but most of the settings have been moved from Control Panel to a much 

simpler interface: the Settings window. 
 

In its default configuration,  

 The Settings window displays iconic representations of the 13 categories of 

settings.  

 Each category icon and name is accompanied by a short list of settings available in 

that category, to give you an indication of where to find specific settings that you’re 

looking for. 
 

It’s easy to locate a specific setting from the Find A Setting search box at the top of each 

page of the Settings window. 
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When you configure settings in the Settings window, your changes are implemented as 

soon as you make them; it isn’t necessary to save your changes, and it’s not possible 

to undo your changes other than by manually reversing each change. 
 

As previously mentioned, Control Panel still exists and you can configure many of the 

less frequently used settings there. The standard Control Panel configuration displays 

category names followed by tasks you can perform in the categories. 
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To open the Settings application 
 

 Click the Start button, and then on the left side area select the Setting icon. 

OR 

 Press Win+I. 
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To open the Control Panel: 
 

 Type Control Panel in the taskbar Search Box. Then, select the Control Panel 

app from the menu. 

OR 

 In the Start menu app list area, select any index letter. In the alphabetic index, 

select W, expand the Windows System folder, and then select Control Panel. 

 

Personalize your Working Environment 

One of the things people like to do with their Windows computers is personalize the 

user interface to reflect things they like and want to see rather than things that other people 

have decided they should see.  

 

To access the Personalization settings: 
 

 Right-click anywhere on the desktop.  

 Select Personalize from the drop-down menu. The Personalization settings will 

appear. 

 

 

 

 

 

 

 

 

 

 

 
 

 

Click the buttons in the setting window below to learn more about using the 

Personalization settings. 
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Configure the Start menu 

Changing the Start menu configuration is a simple one-step process. For example, 

when you turn the full-screen setting on or off, the change takes place immediately. It isn’t 

necessary to sign out of Windows or restart your computer to implement it. 
 

To Resize the Start Menu 
 

 Drag the top border of the Start menu up or down to increase or decrease its 

height. 

 Drag the right border of the Start menu right or left to increase or decrease its 

width. 
 

 

You can change to the full-size Start screen or revert to the default Start menu size, 

and configure other Start menu settings, from the Start settings pane on the 

Personalization page in the Settings window. 
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To switch between the default Start menu and full-size Start screen 
 

1. Open the Settings window by selecting Start and then Settings or pressing Win+I. 

2. Select Personalization, and then on the Personalization page, select Start. 

3. In the Start settings pane, select Use Start full screen. 

4. Select the Start button to test the setting. 
 

 

To remove the app list from the Start menu 
 

1. Display the Start pane of the Personalization settings page. 

2. Turn off Show app list in Start menu. 

3. Select the Start button to test the setting. 
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Pinning and unpinning Apps 
  

To add (pin) a tile to the Start menu: 
 

1. Click the Start button, and then find the desired app from the list. 

2. Right-click the app, then select Pin to Start. In this example, we'll pin the 

Calculator app. 

 

The app will be pinned to the Start menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To delete (unpin) a tile from the start menu: 

 

 Right-click the desired tile, then selecting Unpin from Start. 
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Set the desktop background and system 
colors 

To set one desktop background image 

1. Open the Settings window, select Personalization, and then on the 

Personalization settings page, select Background. 

2. In the Background settings pane, select the Background list and then Picture. 

3. In the Choose your picture area, do either of the following: 
 

 Select a thumbnail to select a Windows 10 image or a previously selected picture. 

 Select Browse. In the Open dialog box, browse to and select the image you 

want to use. Then select Choose picture. 

4. In the Choose a fit list, select Fill, Fit, Stretch, Tile, Center, or Span to 

indicate the way you want to position the image. 
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Or 

1. Start the Photos app. 

2. Locate and select the photo that you want to display as the desktop background. 

3. At the right end of the Photos menu bar, select See more (…) > Set as > Set as 

background. 

 

 

To display a series of desktop background images 
 

1. Place the images you want to display into one folder. 

2. Display the Background pane of the Personalization settings page. 

3. In the Background list, select Slideshow. 

4. If you want to use a folder other than the one shown in the Choose albums for your 

slideshow area (by default, this is your Pictures folder), select Browse. In the Select 

Folder dialog box, browse to and select the folder of images you want to use. 

Then select Choose this folder. 
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5. If you want the background image to change more or less frequently than the 

default of every 30 minutes, expand the Change picture every list and then select 

1 minute, 10 minutes, 1 hour, 6 hours, or 1 day. 

6. If you want to display the folder contents in a random order, turn on Shuffle. 

7. In the Choose a fit list, select Fill, Fit, Stretch, Tile, Center, or Span to 

indicate the way you want to position the images. Consider that image sizes in the 

slideshow might vary. 

 

To set a standard desktop background color 

1. Display the Background pane of the Personalization settings page. 

2. In the Background list, select Solid color to display the color grid. An outline 

and check mark indicate the current background color. 

3. In the color grid, select the color swatch you want to use. 

 
 

To Change the Font Size 

If you have difficulty seeing the text on your computer, you can increase the font size. 

Increasing the font size will also increase the size of icons and other items on your 

desktop. 

1.  Open the Settings app, and then select System. 
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2. The Display options will appear. Use the drop-down arrow to scale up or down the 

size. Note that a larger size may interfere with the way some items appear on the 

screen. 

3. Once you've made your selection, the changes will take effect. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hardware and Sound 
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How to set up a new printer 

Trying to get your new printer up and running? Here are the basic steps you'll follow 

to set up almost any printer 
 

1. Plug in the printer's power cable and make sure it's turned on. 

 

 

 

 

 

 

 

 

 

 

 

 

2. Connect the included cable (usually a USB cable) from the printer to the computer. 

Note: The process will be different if you're using a wireless printer.  

 

 

 

 

 

 

 

 

 

 

 

3. Open the Control Panel, and then select devices and printers. 

4. Select the option Add a printer from devices and printer, then follow the 

instructions that appear. 
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5. Now it's to printing something! For example, you could try printing any page, click 

File > Print from your page, or simply press Ctrl+P on your keyboard. 
 

6. A dialog box will appear. Locate and select the printer name from the list, then click 

Print. 
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To search on the printer driver from Google 

We must write printer name in the browser as shown below: 

 In the example below, we're searching for canon MX920 

 

 

 

 

 

 

 

 

 

Understanding user accounts 

We store personal and business information on computer, and use them to access financial 

and social information online. That information might be protected by a password, but the 

password could easily be accessible to any other person who is using your computer. To 

protect your privacy and the integrity of your information, it is important to control who 

can sign in to your computer, and what they can do when they’re signed in. 

Windows 10 requires at least one user account. You specify that account when you’re 

completing the installation processes, or the first time the computer starts after Windows 

10 has been installed. Windows 10 designates this first account as an Administrator 

account so that the account can be used to manage the computer. 

Each user account is either: 

1. A Microsoft account, which is any email address that has been registered with 

the Microsoft account service. 
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2. A local account that exists only on a single computer and is not associated with a 

specific email address. 

You can use your Microsoft account to sign in to multiple computers, websites, and 

services by using the same email address and password. By signing in with your Microsoft 

account credentials, you can share settings and files among all your devices. Any device 

you sign in to with this account has access to the same settings and information. Signing in 

with a local account places limits on the applications you can purchase or download from 

the Store. 

 

Every user account is also classified as either: 

1. An Administrator account: Administrator accounts are special accounts that are 

used for making changes to system settings or managing other people's accounts. They 

have full access to every setting on the computer. Every computer will have at least one 

Administrator account, and if you're the owner you should already have a password to 

this account. 

2. A Standard User account: Standard accounts are the basic accounts you use for 

normal everyday tasks. As a Standard user, you can do just about anything you would 

need to do, such as running software or personalizing your desktop. 

 

Generally, it's safer to be signed in to a Standard account than an Administrator account. If 

you're logged in as an Administrator, it may actually make it easier for an unauthorized 

user to make changes to your computer. Therefore, you may want to create a Standard 

account for yourself, even if you're not sharing the computer with anyone. You'll still be 

able to make Administrator-level changes; you'll just need to provide your Administrator 

password when making these changes. 

 

User Account Control 

User Account Control (UAC) protects your computer from changes to Windows system 

settings by requiring that an administrator expressly permit certain types of changes. Each 

area of the Windows interface that requires administrator permission is labeled with a 

security icon. When you attempt to access or change protected Windows settings, a User 
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Account Control message box appears, asking for confirmation that Windows should 

continue the operation. The message box varies depending on your account and the action 

 

 

 

 

 

 

 

 

Adding and managing user accounts  

The process for adding and managing user accounts is quite different for each version of 

Windows.  

To add a new user (with a Microsoft account):  

1. Open the Settings app, and then select Accounts. 
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2. Select Family & other users. Scroll down to the Other Users section, then choose Add 

someone else to this PC. 

 

 

 

 

 

 

 

 

3. If the new user already has a Microsoft account, enter the associated email address, and 

then click Next. 
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4. The user can then sign in to the computer with his or her Microsoft account 

information. Note that it may take several minutes to configure a user's settings when 

logging in with a Microsoft account for the first time. 

 

To add a new local user (without a Microsoft account):  
 

1. From the Account settings, click Add someone else to this PC. 

 

 

 

 

 

 

 

2. Select, The person I want to add doesn't have an email address 
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3. The account creation screen will appear. Select Add a user without a Microsoft 

account. 

 

 

 

 

 

 

 

 

 

 

 

4. Enter an account name, and then type the desired password. It's important to choose a 

strong password—in other words, one that is easy to remember but difficult for others 

to guess. When you're finished, click Next. 

 

 

 

 

5. The local user can then sign in to the 

computer with this account. 


